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Copland, Apple’s brand-new
System software is scheduled
for completion in mid-'96.
Tony Smith takes a look at
the user interface that’s
threatening to turn the Mac
world upside down.

It’s August 1995, and there’s a spring in
Apple R&D boss David Nagel's step. Maybe
it’s the sun, perhaps it's the welcome he’s just
received at the start of MacWorld Expo, the bi-
annual American Mac fan fest; possibly it’s the
prospect that the soon-to-be released Windows
95 isn’t quite the Mac killer the Microsoft
marketing machine has made it out to
be. Most likely it’s the knowledge that
Apple’s own next major System
software release, codenamed

Copland, is still on course

for a mid-'96 release.

But, as Microsoft
subsequently learned
with Windows 95,
rewriting an operating
system — the software
that determines the
way a computer
behaves and looks -
from scratch with the
aim of improving it
and retaining
compatibility is by no
means an easy task.
Right up to its launch,
Windows 95 was the
subject of rumours of
features dropped
because they couldn’t
be made to work in

i time. And its arrival saw Microsoft support

i teams deluged with demands for help as PC
i after PC crashed upon installation of the new
i System software. Most of the problems were
i probably due to human error, but either way,
i Microsoft is big enough to carry it off.

Apple, on the other hand, can’t afford the
risk. If Copland is a flop, the company’s
reputation as leader in user
interfaces would be
irreparably damaged.
It wouldn't do a lot
for its financial
stability
either.

But rewriting the Mac OS from the ground

i up is exactly what Apple is doing with Copland.
i No mere bug-fixing update, Copland is to all

i intents and purposes a brand-new operating

i system. Sure, the familiar Mac desktop

i remains, with its folders, icons, pointer and

i menu bar, but the software underneath it, the

i program that makes the Mac do its stuff, is all
i new. So even though work on Copland began

i back in 1993, we won't see the results until the
i middle of next year. Apple is determined to get
i it right — it must get it right — and it’s allowing
i itself the time to do so.

All Systems Go

i So let’s give Apple the benefit of the doubt — no
i easy task when you consider some of its past

i launches; the Newton springs to mind — and

i assume Copland does do what it’s supposed to,
i when it's supposed to — what is it actually

i going to mean for the average Mac user?

If you don’t own a Power Mac or one of the
PowerPC-based Performas, the answer is, not a
lot — around 95% of Copland is accelerated for

Power Mac (what the other 5% is, Apple’s
i keeping mum). Every kind of processor has its

own unique set of instructions — the ‘code’ —
that programmers use to tell it what tasks to

i perform; a program, be it application or

System software, is just a large collection of
these instructions. System 7.5 is predominantly

! written in the instructions used by the 680x0
i family of processors found in the older Macs.
¢ That it runs on a PowerPC-based system is

down to a clever application
called an emulator which
translates on the fly the
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of the features offered
by applications are
actually delivered by the
operating system, a native Copland will also
enhance the performance of other software.

Heart Of The Matter

However, Copland isn’t simply a translation of
System 7.5 into PowerPC format. Early on,
Apple decided it would use this opportunity to
redesign some of the core technologies to
make them perform more efficiently. So they
don’t simply operate more quickly because
you're using a faster chip, but because of the
way they're written to utilise special features of
the PowerPC, such as the ability to handle
more than one instruction at a time.

Take the way Copland handles memory.
Anyone who's used System 7.5 with all its bells
and whistles installed knows that even on an
8Mb Mac there isn’t a lot of room left for most
mainstream applications, certainly not to run
more than one at once. For Power Macs, you're
really looking at 16Mb as your minimum.

Copland, however, has a new Memory
Manager that squeezes much smaller program
segments into Ram than System 7.5 does.
Rarely is an application loaded into memory in
its entirety — instead the Copland Memory
Manager loads the sections currently being
used and those likely to be used.

System 7.5 does this too, but by loading
smaller segments more quickly, Copland will
let you have a greater number of simultane-
ously active programs in a smaller space. More
practically, it means each application will
require less memory. So Apple reckons that the
whole lot will work comfortably in 8Mb of Ram
rather than the 16Mb or so you need today.

. The Copland Memory Manager also
features a much more efficient virtual memory
system — though given how awful the current
one is, anything would be an improvement. So
when a particular application needs more
memory, Photoshop for example, it can be

Copland will let you carry on working, even while it’s doing other things.

assigned it in the traditional way of using a
section of the hard disk to imitate real Ram,
but without the major performance hit that
virtual memory users currently take.

Of course, having several applications
running at once can cause problems besides
those of limited memory. Even when there’s
plenty of Ram, two System 7.5 applications can
easily intrude on each other’s memory
‘territory’ and bang, your Mac freezes or the
infamous ‘Type 1 Error — Application Quit
Unexpectedly’ message rears its ugly head.

To prevent such incidents, Copland protects
an application’s memory allocation from other
applications, including the operating system
itself. It won't necessarily prevent applications
from going splat, but it'll ensure that if they do
they won't drag everything else down too.

Your Fair Share

Beyond making for a more crash-free
environment, this memory protection scheme
is an important component of Copland’s
enhanced ability to run applications simultan-
eously, a process called multi-tasking. Sure, you
can do that right now with System 7.5, but the
program you're using at any one time, the
application in the ‘foreground’, hogs processor
power, leaving little spare for anything running
in the background. Copland’s new multi-
tasking system allots equal share of processor
resources to all currently-open applications.
Apple likes to demonstrate this by copying
three documents simultaneously, but ‘proper’
multitasking goes much further. You can, say,
format a floppy in the background while
you're compressing the software to go on it.
Photoshop can be applying a filter to an image
at the same time as you're laying out in XPress
the page on which the picture will appear.
Copland is about more than making
software faster and more stable, though. A

Microkernels
And Modules

good proportion of Apple’s development efforts
have gone on enhancing the ways with which
you can interact with your System software.
Some of them are just plain gimmicky, but
others really will improve your ability to get the
information you want, when you want it.

Into the former category falls the option to
customise your desktop, not just by changing
the background pattern and the font and
colours used to display windows and menus,
but the very contents of the menus themselves.
In some respects, Apple’s argument for this
makes sense. For example, you might want
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to set up Macs in a school so pupils can use all
the Mac’s facilities bar the Special menu’s
Empty Wastebasket option and the file sharing
commands currently located in the File menu.
Copland will let you decide which commands a
user can give. For most people, though, this
will be a fun but pointless exercise.

More useful are Copland’s ways of using
and examining folders. For example, closed
folders will open automatically (and close when
you're done) whenever you drag a file onto
them. This saves opening several folders to get
to the one you want. To save desktop clutter,
open folders can be dragged to the bottom of
the screen where they’ll become name tags —
click on them and they slide up to reveal their
contents. Drawers will open and shut
automatically when a file’s dragged onto them.

These two items aren’t immediately
impressive — it’s easy to see situations where
they wouldn’t be much use. But they’re exactly
the kind of facility that you soon start to use
without thinking, just like dragging document
icons onto their creator applications. Nowadays
everyone does that, but it too was criticised
initially as an ‘T'll never need that’ feature.

Perfect Presentation

So much for accessing folders — what about
improving the way they present information?
Right now, in System 7.5, a folder represents
the files stored on a section of your hard disk.
In Copland, they can represent not just

that could be located anywhere: on
i your hard disk, on floppies, on a
i network, even on the Internet.

Exit Extensions

physical locations, but list documents

Here’s an example. Let’s say every
evening you want to archive every Adobe
Tlustrator illustration you worked on
during the day. Just create a new folder but

instead of making it display files by type or by

icon, you set it to show ‘All the files I modified

today’. The folder then searches through all the

system resources you're connected to, from

networks to your own hard disk, and lists the
names of the files you
worked on in the last 24

hours.

Open Document:

The result looks like
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f you double-click on an
illustration’s icon, it will
open as usual, but half
of the items may exist
on a Mac on the other
side of the office. Every
time the folder’s opened,
it checks all its pointers
to remote files and
modifies what it displays
if any have been trashed.
If they've been moved,

perhaps to another
folder on the host
machine or even to

another Mac, Copland
will follow them, and

they’ll still appear in
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The new View By Content in the View menu has a search feature.
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Letters folder, in your
Microsoft Word Files
folder, in your Stuff
That's Urgent folder and
in your Items Created
This Week folder. Each

i doesn’t prove to be misplaced.
your folder ready for use. :

& icon points to a single file — there

aren’t four copies on your hard disk —
but you have four different ways of pin-
pointing the letter you're after.

To get this to work, Apple has essentially
merged Find File... with the View menu.
There are other such mixes of features.
AppleGuide in Copland doesn’t just take you

; through tasks to show you how they’re
performed, but its power is combined with
i AppleScript to produce automatically actioned

events. So, you want your wastebasket emptied

i every day at 5pm, just run AppleGuide’s

i Task Manager and at the end it will ask you if
you want to automate the process. Click OK,

i tell it when you want the bin emptied, and

i from that point on you never need select

i the Special menu’s Empty Wastebasket

i command again.

Features like these, combined with the raw

i power of the PowerPC chip mark Copland out
i as a major advance in the way we use Macs,

i probably in the way people use computers

i period. System 7.5 has been a highly popular

i upgrade — by July over five million copies had
i been installed — but it’s really just a minor

tweak compared to Copland.
Whether this new version of the Mac OS

i will deliver the goods, is something we won't

find out for another six months. There've been
rumours that the release time may slip, but at
MacWorld the chipper Mr Nagel was insistent
that the deadline will be met. Copland deserves
to be an impressive and useful operating
system. Let’s hope Nagel's good humour

And There s More...




